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* Queda estrictamente prohibida la copia de datos de secuencias musicales y/o de archivos digitales de audio/graficos/video disponibles en el
mercado, excepto si es para uso personal.

El software y este Manual de instrucciones son propiedad exclusiva de Yamaha Corporation.

Queda expresamente prohibida la copia del software o la reproduccion total o parcial de este manual por cualquier medio sin el consenti-
miento por escrito del fabricante.

Yamaha no representa ni garantiza el uso del software y la documentacion y no se hace responsable de los resultados del uso de este
manual ni del software.

Las pantallas que se muestran en este Manual de instrucciones tienen fines ilustrativos y pueden diferir ligeramente de las pantallas que
aparecen en el ordenador. Aunque las pantallas que se visualizan se basan en la versién Windows, los métodos de funcionamiento son los
mismos para la version Mac.

Windows es una marca comercial registrada de Microsoft® Corporation en Estados Unidos y en otros paises.

Apple y Mac son marcas comerciales de Apple Inc., registradas en los EE. UU. y en otros paises.

MIDI es una marca registrada de la Asociacion de la Industria Electrénica Musical (AMEI).

Los nombres de empresas y productos utilizados en este Manual de instrucciones son marcas comerciales o marcas registradas de sus res-
pectivos titulares.

La licencia de uso de este software se describe en el archivo “Licenses.txt, que se encuentra en la carpeta de instalacion de la aplicacion.

Este Manual de instrucciones asume que usted ya esta familiarizado con las operaciones basicas de Windows/Mac. Si no es asi,
consulte el manual de instrucciones que acompana a su software Windows/Mac antes de utilizar esta aplicacion.

© 2023 Yamaha Corporation
Published 09/2024 CR-BO




Introduccion

Descripcion general de MIDI Song to Style

La aplicaciéon MIDI Song to Style convierte automaticamente canciones MIDI (SMF: Archivo MIDI estdndar; extension: .mid) en
archivos de estilo (.sty), lo que permite reproducir las canciones deseadas como estilos en el instrumento.

Ordenador

MIDI Song to Style

Instrumento

Cancion Estilo
MIDI (.mid) | |:> (-sty) |

Transferencia
mediante cable
USB o unidad flash
uUsB

También puede escuchar y editar los datos convertidos:
- Reproducir canciones MIDI cargadas y cambio de asignaciones de voz para cada canal.
- Escuchar y editar los estilos convertidos.

Precauciones al utilizar la aplicacién

» Esta aplicacion (en lo sucesivo, la “aplicacidn”) recopila de forma andénima datos de uso de la funcion con el fin de mejorar la
calidad del servicio y promocionar productos y servicios relacionados. No se recopilaran los datos que esté editando. Si no
desea enviar el estado de uso, puede desactivarlo desde Ajustes (pagina 13).

* El propésito principal de esta aplicacion es convertir canciones MIDI en archivos de estilo y no esta disefiado para ser utilizado
como un reproductor de musica. Tenga en cuenta que las funciones de previsualizacion de la siguiente aplicacion sélo sirven
como soporte para la edicién, y no se garantiza la compatibilidad total de la reproduccién de audio, etc.

- Reproduccién de canciones MIDI
- Reproduccioén de estilos convertidos
¢ Esta aplicacion sélo puede utilizarse con modelos compatibles con el formato SFF GE (como Genos2).



Instalacion

Conexiones y ajuste

Esta aplicacion se puede utilizar de dos formas: conectandola al instrumento o utilizandola de forma independiente en un
ordenador.

B Uso de la aplicacion conectando el ordenador al instrumento

Se recomienda este método, ya que permite escuchar los cambios tal y como se oirian realmente.

Ejemplo de conexion

Ordenador

Altavoces o
Instrumento salida de audio

——— del instrumento

Q)

MIDI Output Device - Cable USB

MIDI Input Device

Para obtener instrucciones sobre cémo conectar el ordenador al instrumento, consulte el correspondiente manual de
instrucciones.

Queé se puede hacer al conectar al instrumento:

¢ Reproducir archivos MIDI con los sonidos del instrumento.

¢ Escuchar los estilos convertidos con los sonidos del instrumento.

e Guardar (transferir) los archivos de estilo convertidos directamente en el instrumento.

» Especificar acordes en el teclado del instrumento mientras se escuchan los estilos convertidos.

NOTA

Cuando se especifiquen acordes desde el instrumento mientras se escucha en esta aplicacion, asegurese de que el botén [ACMP] del
instrumento esté apagado. (Si utiliza el instrumento con los archivos de estilo convertidos cargados, active [ACMP] como de
costumbre).

Ajustes necesarios:

Abra [Preference] -> [MIDI Device] en el menu de la parte superior de la aplicacion y, a continuacion, configure el puerto como se
indica a continuacion.

* MIDI Input Device: Salida MIDI del instrumento

e MIDI Output Device: Entrada MIDI del instrumento

NOTA

Tanto la entrada como la salida deben estar configuradas en el instrumento para que la transferencia de archivos sea correcta.



Instalacion

B Utilizar la aplicacion de forma auténoma con solo un ordenador

Se puede utilizar esta aplicacion por si sola, sin necesidad de conectar el instrumento al ordenador. Aunque las voces y estilos
no se reproduciran con la misma precision, este método le permite trabajar sélo con el ordenador.

Ejemplo de conexion

Ordenador

Altavoces del

Sintetizador Dispositivo de ordenador
de software | — | audio interno | —» Q )))
integrado del ordenador

Teclado MIDI, etc.

Tt i’
v U

Lo que se puede hacer sélo con un ordenador:

* Reproducir canciones MIDI utilizando los sonidos del sintetizador de software dentro de la aplicacion (*1).

* Escuchar los estilos convertidos con los sonidos del sintetizador de software dentro de la aplicacion (*1).

» Guardar el archivo de estilo convertido en el ordenador o transferirlo al instrumento mediante una unidad flash USB.

» Especificar acordes en la paleta de acordes de la aplicacion (pagina 14) mientras se escuchan los estilos convertidos.
*1) Los sonidos no se reproduciran con total precision.

Ajustes necesarios:

Abra [Preference] -> [MIDI Device] en el menu de la parte superior de la aplicacion y, a continuacion, configure el puerto como se
indica a continuacion.

* MIDI Input Device: Ninguno (debe seleccionarse si se dispone de un teclado MIDI, etc.)

e MIDI Output Device: MIDI Song to Style Synth, asi como un dispositivo de audio para producir sonido



Instalacion

B Importar la lista de voces

Al cambiar las voces de cada canal de una cancion MIDI que se ha cargado en esta aplicacién (pagina 26), se pueden
seleccionar las voces de la lista de voces de la aplicacion. La lista de voces para la version 1.00 del firmware Genos2 es la lista
inicial de esta aplicacion.

Al importar la lista de voces, se pueden hacer coincidir la lista de voces de esta aplicacion con la del instrumento vinculado.
Para los productos compatibles, la informacién sobre el archivo de lista de voces para MIDI Song to Style se puede encontrar en
la pagina del producto en el sitio web de Yamaha (https://www.yamaha.com/).

1. Seleccione [Edit] -> [Import Voice List] en el menu de la parte superior de la aplicacion.
Se abrira una ventana de seleccién de archivos.

2. Seleccione la lista de voces (.txt) del instrumento.

La lista de voces de la aplicacién se actualizara con la lista cargada.
Si no aparece ninguin mensaje de error, la carga ha finalizado.



Guia Rapida/Descripcion general

Como utilizar MIDI Song to Style

B La forma mas sencilla de utilizarlo: Convertir y transferir

Ordenador

MIDI Song to Style
- Instrumento

1
Cancion
MIDI (.mid) I l:>

Estilo
(-sty)

Transferencia
mediante cable
USB o unidad flash
UsB

0 . L.
Drop a MIDI file or project here. Archivo de cancion MIDI
Formato de archivo MIDI estandar
(.mid)

La cancion MIDI que se ha transferido se analiza automaticamente y se convierte en un estilo, lo que permite reproducir y
editar el estilo convertido dentro de la aplicacién (pagina 17).

NOTA

También puede asignar secciones y partes utilizando meta eventos (marcadores y nombres de pista) que haya incrustado en la cancién
MIDI de antemano, en lugar de utilizar los resultados del analisis automatico.

Consulte la pantalla Otros ajustes (pagina 13) para ver los ajustes necesarios para activar esta funcioén, y la tabla (pagina 32) para ver
el formato de los meta eventos que deben incrustarse en la cancién MIDI.

2 » Transfiera los resultados del analisis como un archivo de estilo al instrumento. (Haga clic en
el icono )
Existen dos formas para realizar la transferencia:
A) Guardar el archivo de estilo directamente en el instrumento a través de la conexion del cable USB (Guardar
en el instrumento).
(Puede transferir el archivo cuando el ordenador esté conectado al instrumento mediante un cable USB. Consulte
pagina 3 para los ajustes necesarios).
B) Guardelo como un archivo de estilo en una unidad flash USB y luego transfiera el archivo al instrumento
(Guardar en el ordenador).

3. Toque el instrumento con el estilo transferido.



Guia Rapida/Descripcion general

B Reanalizar cambiando las condiciones del analisis

Si los resultados de la conversion automatica de estilo no son los deseados, puede cambiar las condiciones del analisis y
convertir de nuevo la canciéon MIDI que se ha cargado.

* No incluya el canal de melodia principal ni otros canales que no desee incluir en el estilo (pagina 20).

B Editar el estilo convertido automaticamente

Puede editar manualmente el estilo convertido automaticamente de las siguientes maneras.

» Cambiar el registro extraido de una cancién MIDI como una seccién (pagina 21)

* Reordenar secciones (pagina 22)

» Seleccionar un nuevo registro y asignarlo a una seccion (pagina 23)

e Cambiar las asignaciones de canal MIDI de cada parte de estilo para cada seccidn (pagina 25)
e Cambiar la voz de cada canal de una cancion MIDI (pagina 26)

» Cambiar/restablecer el volumen de cada parte de un estilo (pagina 27)

» Cambiar el compas del estilo o la signatura de compas (pagina 28)




Guia Rapida/Descripcion general

Guardar o cargar los datos editados hasta el momento (Proyecto)

Se pueden guardar o cargar las canciones MIDI, incluyendo la informacién analizada y los contenidos editados, como un archivo
de proyecto en un formato de archivo especifico (.sts).

En el archivo del proyecto se guardan los siguientes contenidos:

¢ Contenido de la cancion MIDI cargada (archivo SMF)

* Resultados del analisis automatico de una cancién MIDI

» El estado de edicion del estilo, incluidas las asignaciones de secciones y partes

BGuardar un proyecto
Abra [File] -> [Save Project] en el menu de la parte superior de la aplicacion y especifique la ubicacion para guardar.

B Cargar un proyecto
Abra [File] -> [Open Project] en el menu de la parte superior de la aplicacion y seleccione el archivo de proyecto deseado.
También puede arrastrar y soltar el archivo del proyecto en la aplicacion.




Funciones (Descripcion de la pantalla)

Transiciones de la pantalla

A continuacion se muestra un esquema de las transiciones de visualizacion que aparecen tras iniciar la aplicacion.

Al inicio

Ajustes MIDI

Carga de archivos

Inicio (Easy)

Paleta de acordes (ventana independiente)

LLILLLE

Guardar Estilos

Sample_MIDI_Song.mid

%

<«

Edicion detallada (ventana aparte)

£ MDiSong o Se —

Part 11 13 RS MC O IFRWPBNRENFD) o &1 '£2 €5

Melodypart

P4 pa Pd Pd Pd o Pa P
A w

mRRRRRR R

NRRRARRRRRERRRY

Save to Instrument

il

Edicion de los parametros de la seccion

1w v

12768) v

8E) v | Lolim



Funciones (Descripcion de la pantalla)

Funciones de la pantalla

En este apartado se explica qué se puede hacer desde cada una de las pantallas mostradas en el esquema anterior.

B Pantalla Inicio (Easy)

B MIDI Song to Style - X

File Edit Preference Help

I |
=t

Intro " Intro I"

> » > >
Main A Main B Main C Main D

= ~ Y4 = —
‘ %) 1) =

L

> »> > »>
L rinA J|_rnB J{_FnC J_FuD )

=t

g

(D Controles para la reproduccion de canciones MIDI

(2 Abre la pantalla para cargar un nuevo archivo

(3 Cambia el modo de visualizacion de inicio (Easy < Edit)
@ Abre la ventana Ajustes MIDI (pagina 12)

(5 Abre la ventana Otros ajustes (pagina 13)

(& Para reproducir secciones del estilo convertido (pagina 17)

(@ Muestra el acorde especificado durante la reproduccién del estilo y abre la ventana de la paleta
de acordes (pagina 14)

Abre la pantalla Guardar estilo (pagina 19)



Funciones (Descripcion de la pantalla)

B Pantalla de inicio (Edit)

BB MIDI Son

Las funciones (D a (® son las mismas que las de la pantalla Inicio (Easy).
(@ Vuelve a analizar después de cambiar la configuracion del analisis automatico (pagina 20).

Comprueba y gestiona cada canal para la reproduccion de la cancion MIDI.

¢ Muestra el tipo aproximado de voz (sélo en pantalla).
* Determina el ajuste de activado/desactivado (silenciamiento) de cada canal.

@D Muestra la descripcion general de los datos de la cancién MIDI y permite editar las secciones
de estilo.

* Muestra la descripcion general de datos de cada canal para una cancion MIDI (sélo visualizacion).
 Edita la seccion de estilo (pagina 21).
* Cambia las asignaciones de canal MIDI de cada parte de estilo (pagina 25).

@2 Cambia la ampliacién de la visualizacion de la descripcion general de los datos de la cancion

MIDI ().

@3 Muestra y permite cambiar varios ajustes del estilo (paginas 18, 27).
e Tempo (so6lo visualizacion)
» Signatura de compéas (Compas)
* Activado/Desactivado y volumen de cada parte de estilo
¢ Tecla de seccion

11



Funciones (Descripcion de la pantalla)

HBPantalla de ajustes MIDI

MIDI Input Device

MIDI Output Device

(D Determina el MIDI Input Device.

(2 Determina el MIDI Output Device.
Si selecciona “MIDI Song to Style Synth’; también tendré que configurar el destino de salida del audio.

(® Actualiza la lista de dispositivos MIDL.

12



Funciones (Descripcion de la pantalla)

B Pantalla de otros ajustes

0 Style File

Total Max Size 128 KB
e Chord Palette

® Open and close automatically when style playing

Beat v

: ze Song Meta Events for assigning Sections/Parts
n S Ma M L)

(1) Determina el tamaino maximo de los archivos de estilo convertidos.

(2 Determina si la ventana Paleta de acordes (pagina 14) se abre automaticamente al reproducir un
estilo.

(3 Determina cémo se maneja la informacién incrustada en la cancién MIDI.

Hay dos elementos.

* Seleccione una de las siguientes informaciones para que se muestre en la parte superior de la pantalla Inicio
(Edit).
- None: no se muestra nada.
- Marker: muestra el texto del meta evento (marcador).
- Beat: muestra el compas (signatura de compas).
- Tempo: muestra el tempo.
- Chord (XF): muestra el acorde.

¢ Active/desactive la funcidn para utilizar meta eventos en la canciéon MIDI para asignar secciones y partes.
Cuando se utiliza esta funcion, las secciones y partes se asignan utilizando solo los meta eventos incrustados, sin utilizar
los resultados del andlisis automatico. Esto significa que si incrusta informacién en la cancién MIDI de antemano, puede
asignarlas de la forma especificada.
Los marcadores se utilizan para asignar secciones y los nombres de pista se utilizan para asignar partes de estilo.
Para conocer las cadenas que pueden utilizarse para especificar secciones/partes, consulte la tabla de la pagina 32.

(@ Determina si se permite la recopilacion de datos anénimos sobre el estado de uso de esta
aplicacion.

13



B Ventana Paleta de acordes

Funciones (Descripcion de la pantalla)

Esta ventana le permite especificar el acorde utilizado cuando se reproduce el estilo.

C[D FIG]A]B

-_: e e_™") M M  r rer - k,k e
—————————— —————————————————————\\

On Bass
on—

Emin
os ]

(D Especifica la raiz del acorde.

(2 Especifica el tipo de acorde.

La abreviatura “cc” significa “acorde cancelado” (sin acorde especificado).

(3 Activa/desactiva el acorde En bajo y le permite especificar la nota de bajo.

(@ Muestra el acorde especificado.

14



B Ventana Edicion detallada

Funciones (Descripcion de la pantalla)

Esta ventana le permite editar los ajustes del canal de la canciéon MIDI y cambiar los ajustes detallados de cada parte en la

seccioén de estilos.

E MIDI Song to Style

G|

FD" BK E1 E2 E3

T —
I3 'MA'MB MC MD FA"FB FC FD" BK E1 E2 E3

Program Ne = Voice Name |

18

20

0

20

0

cC oo

C

(<]

(D Controles para la reproduccion de canciones MIDI.

(2) Determina el ajuste de activado/desactivado (silenciamiento) de cada canal MIDI.

(3 Restablece la configuracién del canal MIDI.

Restablece el estado anterior a la edicion.

(@) Determina la voz para cada canal MIDI.

Puede especificarlo mediante nimeros de cambio de programa o nombres de voz.
La lista de voces importada (pagina 5) se utiliza para configurar el nombre de la voz.
Los colores dados a los numeros de voz o a los nombres de voz indican las siguientes condiciones.

0 40 31 Blanco

Sin editar y la voz no cambiara durante la secuencia.

0 113 31 Amarillo

Sin editar y la voz cambiara durante la secuencia.

La voz se ajusté manualmente.

(® Determina el volumen para cada canal MIDL.

15



Funciones (Descripcion de la pantalla)

(6 Muestra el estado del volumen de cada canal MIDI.

Los tres tipos de condiciones de volumen se indican a continuacion.

Blanco Sin editar y el volumen no cambiara durante la secuencia.

Amarillo Sin editar y el volumen cambiara durante la secuencia.

Naranja El volumen se ajusté manualmente.

ol

(@ Restablece todos los ajustes de los canales MIDI.

Muestra el estado de asignacion de cada canal para la seccion y abre los ajustes detallados de
las partes de estilo.

Muestra las asignaciones de parte para cada canal en cada seccion del estilo.
Se utilizan las siguientes abreviaturas de pantalla.

Nombre de la seccién

11a3 Intro I a lll
MA a MD Main AaD
FA a FD FillnAaD
BK Break
E1aE3 Ending I a lll

Nombres de las partes del estilo

R1, R2 Rhy1, Rhy2
Bs Bass
C1,C2 Chd1, Chd2
Pd Pad

P1, P2 Phr1, Phr2

Haciendo clic en el nombre de cada parte de estilo podra editar los parametros detallados de las partes dentro de cada
seccion.
Si desea mas informacion detallada sobre los parametros, consulte pagina 33.

NOTA
Dado que los parametros detallados se ajustan automaticamente en funcidn de los resultados del andlisis, normalmente no es
necesario editarlos.

(9 Cambia las asignaciones de parte.

Puede cambiar las asignaciones de parte para cada canal MIDI a la vez. Cuando se especifica una parte para el canal
deseado, ese canal se asigna a la parte especificada para todas las secciones.

NOTA

Si desea asignar canales diferentes para la parte de cada seccién, cambie las asignaciones individualmente en la pantalla Inicio
(Edit) (pagina 25).

16



Como utilizar la aplicacion

Reproducir (escuchar) el estilo convertido

Puede probar como suena el estilo convertido mientras especifica el acorde.

B Reproduccion de estilos

1. Haga clic en el icono correspondiente a la secciones que desee reproducir.

[ rnA J| FnB Fi G FinD )

%) mioi

£ Setting

>
intrall | intro [l

_ A J_FuB J|_fnC J FuD |

ending Il

En este ejemplo, se reproduce Main B.
Ademas, por defecto, la ventana Paleta de acordes (pagina 14) se abre automaticamente.

2. Controla la reproduccion de estilos, como el cambio de secciones y la especificacion de
acordes.
¢ Si hace clic en el icono de otra seccion, se reproducira esa seccion.
¢ Puede comprobar el cambio en el sonido mientras especifica el acorde desde la ventana Paleta de acordes o el
instrumento que se ha seleccionado como MIDI Input Device.

3. Haga clic en el icono de la seccion que se esta reproduciendo para detener la reproduccion
del estilo.

Determina el ajuste de activacidon/desactivacion de la reproduccion del bucle de
seccion.

Con los ajustes predeterminados de esta aplicacion, cada seccion se reproduce en un bucle que permite comprobar el
contenido del estilo. Este comportamiento difiere del de los instrumentos normales equipados con estilo. Si desea cambiar el
comportamiento de las secciones que normalmente no se reproducen en bucle (Intro I a lll, Fill In A a D, Break y Ending | a Ill)
para que no se reproduzcan en bucle, haga clic en la marca en la parte superior derecha del icono. La pantalla cambiara a
E (bucle desactivado) y esas secciones se reproduciran sélo una vez, y luego se reanudara la reproduccion del estilo, como
es habitual en los teclados digitales equipados con estilo.

17



Como utilizar la aplicacion

B Activacion/desactivacion de cada parte de estilo durante la reproduccion

En la pantalla Inicio (Edit), puede activar/desactivar (silenciar) cada parte.

LI

B setting

En este ejemplo, Chd1 y Chd2 estan desactivados.

18



Como utilizar la aplicacion

Guardar y transferir los estilos convertidos

Los resultados de la conversiéon pueden guardarse en el ordenador o transferirse al instrumento conectado como archivo de estilo
(.sty).

1. Haga clic en el icono 8.

& MIDI Song to Style - x

File Edit Preference Help

( save to Computer ) Save to Instrument

| ]

NOTA

Si desea cancelar la operacién de guardado, haga clic de nuevo en el icono .

2 = Seleccione como para guardar el archivo.

* [Save to Instrument]: Permite transferir y guardar archivos de estilo directamente en el instrumento.
El archivo se guardara en la carpeta raiz de la unidad de usuario.
* [Save to Computer]: Guarda los archivos de estilo en el ordenador.

NOTA
[Save to Instrument] sélo puede utilizarse cuando el ordenador esté conectado al instrumento por un cable USB. Consulte las
instrucciones en pagina 3.

3. Siga las instrucciones en pantalla para guardar o transferir.
A) Para [Save to Instrument] (transferir directamente al instrumento)

Save to root folder
of the User drive.

Save to Instrument

[

Escriba un nombre y haga clic en [Save to Instrument] para iniciar la transferencia.
B) Para [Save to Computer] (guardar en el ordenador)
Cuando aparezca el cuadro de didlogo para guardar el archivo, escriba un nombre y guardelo en la ubicacién
deseada.
Cuando transfiera datos al instrumento, utilice una unidad flash USB.

19



Como utilizar la aplicacion

Cambiar los ajustes predefinidos del analisis automatico
Las condiciones de andlisis de las canciones MIDI se ajustan automaticamente, pero ello puede dar lugar a resultados no

deseados en funcidn de los datos MIDI concretos. La opcion de incluir o no cada canal en el analisis puede modificarse para
volver a analizar los datos y obtener los resultados deseados.

B Especificar manualmente los canales que desea excluir del analisis y volver a analizarlos

1. Ponga la pantalla Inicio en modo Edit.

[4 Edit

2. Haga clic en [Reanalyze Setting].

Song: Sample_MIDI_Song.mic

@I @aaNaa# 19

Se abrira la pantalla de ajustes del andlisis.

3. Cambie los ajustes de exclusion de canales tal como desee.

Melody [ Assign

13 'MA'MB MC MD FA FB FC FD BK E1 E2 E3

MelodyPart

[T

Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd Pd

I

ct|ct|ctfcticafct|clfcct ci|a|alcafc|ci|ci|ct|ct

[

Bs Bs Bs Bs Bs Bs Bs Bs Bs Bs Bs Bs Bs

[

P P

[

a2|e|a|cilc ae|a|alala|a

[

R1 R1

[

R2 R2 R2 R2 R2 R2 R2 R2 R2 R2 R2 R2 R2 R2

OEHEEOEE

[

Reanalyze Cancel Reanalyze

Edite las marcas de verificacion de las fichas [Melody] y [Assign] segun sea necesario.

* Pestafia [Melody]: Los canales marcados se trataran como la “melodia principal”
Los canales de la melodia principal se utilizan para estimar el registro de la seccién.
Cuando active la pestafia [Melody], la pestaia [Assign] se desactiva automaticamente.
Para el valor inicial, se reflejan los resultados de la identificacion automatica de la melodia principal.
Marque los canales que desee especificar como melodia principal (por ejemplo, el canal que
contiene las notas que desea reproducir).

* Pestafia [Assign]: Los canales marcados son partes que pueden asignarse a partes de estilo.
Si no quiere que el sonido de interpretacion de un canal especifico se incluya en el estilo convertido,
desmarque ese canal.

4. Haga clic en [Reanalyze] para volver a realizar el analisis.
Se actualizaran los resultados de la conversion.
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Como utilizar la aplicacion

Editar el estilo convertido

En el modo Edit (pagina 11) de la pantalla Inicio, puede modificar un estilo convertido automaticamente segun sea necesario para
lograr el resultado de conversion que desee.

NOTA

Las operaciones de edicién introducidas en este capitulo pueden deshacerse o rehacerse utilizando [Edit] -> [Undo]/[Redo] en el menu de
la parte superior de la aplicacion.

B Modificar el reqgistro de las secciones

1. Haga clic en el nombre de la seccion en la parte superior de la pantalla y seleccione la
seccion cuyo registro desee cambiar.

La seccién seleccionada quedara resaltada. En este ejemplo, se ha seleccionado Intro II.

2. Arrastre el borde derecho o izquierdo del registro de seccién para ajustar el registro como
desee.

Intro 1l Intro 1l

Se ha modificado el registro de la seccion.
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Como utilizar la aplicacion

B Reordenar las secciones

Si los resultados de la asignacion automatica de secciones no estan en el orden deseado, puede reordenar las secciones.

1. Haga clic en el nombre de la seccion en la parte superior de la pantalla y seleccione la
seccion desee cambiar.

Main C FillB__ Intro Il

Main B

La seccién seleccionada quedara resaltada. En este ejemplo, seleccionamos Main D.

2. Vuelva a hacer clic en el nombre de la seccion seleccionada.

Intro Main

A

Assign

Se abre la ventana emergente para la asignacion de secciones.

3. Seleccione el nombre de seccidn para el destino de sustitucion y haga clic en [Assign] para
confirmar.

Se ha modificado la asignacion de la seccion. En este ejemplo, se han sustituido Main A y Main D.

NOTA

Puede mantener la naturalidad sustituyendo la seccién Main y la seccién Fill In como un conjunto.

Puede mantener una sensacion natural sustituyendo la seccién Main y la seccion Fill In como un conjunto. Por ejemplo, cuando
sustituya Main B por Main C, debera sustituir también Fill B por Fill C para garantizar la coherencia entre los patrones.
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Como utilizar la aplicacion

B Asignhar una nueva seccién (manualmente)
Puede especificar el registro deseado que se utilizara para asignar una nueva seccion.

1. En la pantalla, seleccione el registro al que desea asignar.

Intro Intro

Se visualizara el registro seleccionado.

2. Haga clic en [ + 1.

Se abre la ventana emergente para la asignacion de secciones.

3. Seleccione el nombre de la seccion a la que desea asignar el registro seleccionado y haga clic
en [Assign] para confirmar.

¢ Cuando seleccione una seccion sin asignaciones existentes, se afiadira una nueva seccion.
* Cuando seleccione una seccion con asignaciones existentes, la seccion existente se eliminara y se sustituira por el
nuevo registro.

Intro |

En este ejemplo, el registro seleccionado se afade como Intro 1.
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Como utilizar la aplicacion

B Borrar secciones

Puede borrar las secciones innecesarias.

1. Haga clic con el botén derecho del ratén en el nombre de la seccion que desea borrar.

( Introlll )
L3

i
Delete Intro Il

Se abre un menu de borrado.

2. Haga clic en [Delete <Nombre de seccion>].
La secciones se borrara.
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Como utilizar la aplicacion

B Cambiar la combinacion de partes vy canales MIDI dentro de una seccion

La asignacion para la cual los canales MIDI individuales se convierten en partes de estilo especificas puede cambiarse de

manera independiente para cada seccion.

1. Haga clic en nombre de la seccidon en la parte superior de la pantalla y seleccione la seccion
que desee cambiar.

Se mostrara el estado de asignacion de canal para cada Parte en la seccion seleccionada.

2. Arrastre y suelte la parte cuya asignacion desea cambiar.

d Reanalyze Setting T d Reanalyze Setting intro

Introl Intro |

nth Lead

Guiter
% Guiter
% Guiter

Se han sustituido la parte de fuente de arrastre y la parte de destino de arrastre.

Borrar o anadir partes de una seccion
Puede borrar una asignacién de parte haciendo clic en el icono [-] situado junto al nombre de la parte.

Se muestra un icono [+] para los canales no asignados que tienen datos de interpretacion dentro del registro de la seccion.

Haciendo clic en ese icono [+] podra seleccionar y asignar una parte de seccion.

~————T7#0 [RhyT "Rhy2| Bass
Chd1 Chd2- Pad

NOTA
Si desea establecer las asignaciones de parte a canales para todas las secciones a la vez, puede hacerlo en la ventana de edicién

detallada (pagina 15).
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Como utilizar la aplicacion

B Cambiar la voz de cada canal de una cancion (Edicion detallada)

Puede pasar de las voces genéricas especificadas en una cancién MIDI a las voces de mayor calidad exclusivas del instrumento.

1. Seleccione [Edit] -> [Open DetailEdit Window] en el menu de la parte superior de la
aplicacion.
Se abre la ventana para una edicion detallada.

2 = Cambie los ajustes de voz para cada canal.

Song: Sample_MIDI_Song.mid

e ——
13 'MA"MB MC MD 'FA"FB FC FD' BK E1 E2 E3

MelodyPart

Pd Pd Pd Pd

@ aa

s Bs Bs Bs

2

R2 R2 R2

P1
13 "MA"MB MC MD "FA"FB FC 'FD' BK E1 E2 E3

@ Reset All Ch Cancel

Puede ajustarlos por medio de numeros de cambio de programa o nombres de voz.
La lista de voces importada (pagina 5) se utiliza para configurar el nombre de la voz.
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Como utilizar la aplicacion

B Cambiar/restablecer el volumen de cada parte de un estilo

Puede cambiar el volumen de cada parte de estilo en todas las secciones.

LI
B setting

El volumen de cada parte puede ajustarse accionando los mandos situados debajo de los hombres de cada parte de estilo.
Alternativamente, los valores pueden editarse directamente.

Si desea restablecer el volumen modificado a su estado inicial (el estado cuando se cargé la cancién MIDI), realice una de las

siguientes acciones:

* En el menu de la parte superior de la aplicacién, abra [Edit] -> [Reset Style Parameter] -> [Volume] y seleccione la parte que
desee restablecer.

* Mantenga pulsada la tecla CTRL (Windows) o Comando (Mac) y haga clic en el mando correspondiente a la parte que desea
restablecer.

Si desea restaurar el cambio anterior, seleccione [Edit] -> [Undo].
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Como utilizar la aplicacion

B Cambiar el compas del estilo (Signatura de compas)

Puede cambiar los ajustes del compas del estilo (signatura de compas) después de la conversion.
Haga clic en la zona “Beat” de la parte inferior de la pantalla y ajuste el valor.

Style Beat Editor Section All

1112 13 MAMB Mc MD'FA FB FC FD BK E1 E2 E3

4 4 4 4 4 4 4 4 4 4
Main A

4 v /

Cancel Cancel

B Cambiar la tecla de la seccion de estilo

Section key (Section Key Signature) es un parametro que indica en qué clave se basan los datos de cada seccion.

Cuando especifique acordes con la misma nota fundamental que esta clave durante la reproduccién del estilo, las secciones Intro
y Coda se reproduciran con el mismo tono que la cancién MIDI antes de la conversion. Seleccione el nombre de la seccién que
desea cambiar en la parte superior de la pantalla y, a continuacion, haga clic en el area “Section Key” en la parte inferior de la

pantalla para establecer el valor.
Main A
Gmaj
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Terminologia

B Canciones MIDI (SMF)

» Datos de partituras de musica electronica. Cargar esos datos en un dispositivo compatible permite reproducir musica.
* Incluye 16 “Canales” que permiten especificar diferentes voces (sonidos de instrumentos), volumen y contenido de
interpretacion.

* SMF (archivo MIDI estandar) (.mid) es el nombre del formato estandar de los archivos MIDI.

B Términos relacionados con el estilo

Seccion:

Grupo colectivo de datos musicales (o patrdn) que se utiliza para construir una cancion.
En funcion del progreso de la interpretacion o de la cancion, las secciones cambian automatica o manualmente.
Las secciones incluyen Intro I-1ll, Main A-D, Fill In A-D, Break y Ending I-Ill.

Ejemplo de reproduccion:

> Parada

Oberacién INTRO START/ MAIN ENDING
peraci 1 STOP B] [i]
Reproduccion Intro | Main A FillIn B Main B | Ending Il
de estilos "| (una vez) (bucle) "| (una vez) (bucle) "| (una vez)
NOTA

La conversién automatica en MIDI Song to Style siempre deja algunas secciones (Intro |, Break, Ending |, Ending Ill) sin asignar, por lo

que es necesario (y deseable) asignarlas manualmente.

Parte:

Un componente dentro de una seccién. Las voces, etc. pueden ajustarse individualmente para cada parte. Las partes son

equivalentes a los canales de una cancion MIDI.

Las partes incluyen Rhythm 1-2, Bass, Chord 1-2, Pad, y Phrase 1-2.

Main A Main B
| Rhythm 1 | | Rhythm 1 |
| Rhythm 2 | | Rhythm 2 |
| Bass || || oBass |
| chod1 || || cChord1 |
| chod2 || || chord2 |
| Pad  |||| Pad |
| Phrase1 || || Phraset |
| Phrase2 || || Phrase2 |

Archivo de estilo:
El formato de archivos de estilos (SFF) es un formato relacionado con la funcién de acompafnamiento automatico de Yamaha

(estilo).

Existen dos formatos: SFF y SFF GE.
SFF GE (Edicidn para guitarra) es un formato ampliado de SFF que mejora aun mas la expresividad de las voces de guitarra.
MIDI Song to Style exporta archivos de estilo en formato SFF GE.
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Lista de menus

Apéndice

Menu

Descripcion

Open SMF

Carga archivos de canciones MIDI (.mid,.midi).

Save Style File

Guarda el archivo de estilo convertido en el ordenador.

Open Project

Carga el archivo de proyecto (.sts) y reproduce el estado de edicién en el momento de
guardar.

File save Proct S;EZ; ﬁ(l) p(f(s)z,:)?to que se estd editando en un archivo de proyecto en formato
Recent Files Selecciona los archivos abiertos recientemente.
Exit (Quit)* Sale de la aplicacion.
Undo Devuelve el estado de edicién al paso anterior.
Redo Después de aplicar Undo, avanza el estado de edicién un paso hacia adelante.
Open DetailEdit Window Abre la ventana Edicién detallada.
Edit Importa la lista de voces.
Import Voice List NOTA
La lista de voces se utiliza para especificar voces en la ventana de edicion detallada.
Reset Style Parameter Volume Restablece el volumen para cada parte del estilo.
Manual Visualiza el Manual de instrucciones (este documento).
Help Privacy Statement Muestra la politica de privacidad.

About*

Muestra la version de la aplicacion y el copyright.

* Para la version Mac, este menu se encuentra en el menu de la aplicacion “MIDI Song to Style”
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Teclas de acceso directo

Apéndice

Operacion

Atajo

Carga un archivo de cancién MIDI (.mid)

Ctrl + Mayus + O

Guarda un archivo de estilo (.sty)

Ctrl + Mayus + S

Cargar un archivo de proyecto (.sts) Ctrl+ O
Guardar un archivo de proyecto (. sts) Ctrl+S
Undo Ctrl+Z
Redo Ctrl + Mayus + Z

Abrir la pantalla de edicion detallada

Ctrl + Mayus + D

Reproducir/parar una cancién MIDI

Tecla de espacio

Posicion de reproduccion de la cancion MIDI: avanzar un compas

. (punto)

Posicion de reproduccion de la cancién MIDI: retroceder un compas

, (coma)

Reproducir/parar un estilo (seccién seleccionada actualmente)

Mayus + tecla de espacio

Hacer clic en [OK] Entrar
Hacer clic en [Cancel] Esc
Cerrar la ventana independiente activa Ctrl + W
Pantalla Inicio (Edit): acercarse a la descripcién general de los datos de la cancién MIDI H
Pantalla Inicio (Edit): alejarse de la descripcién general de los datos de la cancién MIDI G

NOTA

¢ Es posible que las teclas de acceso directo no estén disponibles inmediatamente después de introducir los nimeros en el teclado. Si
esto ocurre, pulse una vez en cualquier lugar de la pantalla para activar los accesos directos.

* Para Mac, sustituya Ctrl por Comando.

e Las teclas de acceso directo solo funcionan cuando la ventana correspondiente esta activa.

31



Apéndice

Textos de meta eventos al especificar secciones y partes (marcadores, nombres de pista)

Esta es una tabla de las cadenas validas que reconoce correctamente la aplicacion cuando se especifican secciones y partes
utilizando meta eventos dentro de una cancién MIDI. Si desea ver una descripcion general de las funciones, consulte la pantalla
Otros ajustes (pagina 13).

Para especificar secciones: meta evento 06 (marcador)
El area desde un marcador valido hasta el siguiente marcador valido se asignara como la seccion especificada.

Operacion Atajo
Intro | Intro i, Intro 1, Intro A
Intro Il Intro ii, Intro 2, Intro B
Intro Il Intro iii, Intro 3, Intro C
Main A Main A
Main B Main B
Main C Main C
Main D Main D
FlllIn A Fill A
Fill In B Fill B
FilllInC Fill C
Fill In D Fill D
Break Break
Ending | Ending i, Ending 1, Ending A
Ending Il Ending ii, Ending 2, Ending B
Ending Il Ending iii, Ending 3, Ending C
End of Section End of Section, End, EOS

Para especificar partes: meta evento 03 (nombre de secuencia/pista) o 04 (nombre de instrumento)
Si el nombre de pista/nombre de instrumento de un canal coincide con uno de los nombres de la siguiente tabla, el canal se
asigna a la parte correspondiente.

Parte Texto en meta evento
Rhythm 1 Rhythm1, Rhy1, AddDrum
Rhythm 2 Rhythm2, Rhy2, MainDrum
Bass Bass
Chord 1 Chord1, Chd1
Chord 2 Chord2, Chd2
Pad Pad
Phrase 1 Phrase1, Phr1
Phrase 2 Phrase2, Phr2

NOTA
En el texto de los meta eventos solo pueden utilizarse caracteres alfanuméricos (juego de caracteres ASCII).

Si se utilizan caracteres de doble byte, el texto sera confuso y no se reconocera correctamente.
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Ventana de edicidn detallada: Editar los parametros de seccién

La ventana de edicion de los parametros de seccidn se abre al hacer clic en una parte dentro de una seccion en la ventana
Edicion detallada (pagina 15).

Attribute
Style Part
Zone Setting

Lo Zone Main Zone Hi Zone

Split B Mega

Style Playing Parameter Style Playing Parameter
Guitar Stroke W
to Style Parameter Convert to St arameter

no change v Guitar Stroke ¥

HiKey 10C# v HiKey 7@ -
HiLim 127 (G8) ¥ HiLim 127 (G8) ¥

LoLim 28(E0) ¥ LoLim 02 v

Cancel
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B Descripcion de cada elemento de la pantalla

Nombre del elemento

Descripcion

Section Setting

—

Cambia la seccién a editar.

Sélo para este elemento, la visualizacion del nombre de la seccidn difiere de la
visualizacién normal. Sustituya los nombres de las secciones por los siguientes
cuando los vea:

¢ Intro A-C: Intro I-1lI

« Fill In AA-DD: Fill In A-D

« Fill In BA: Break

* Ending A-C: Ending I-llI

Key Signature

Determina la Section Key Signature.

Channel Setting

Cambia el canal MIDI a editar dentro de la seccién seleccionada.

Attribute

Muestra los atributos del canal (resultados del andlisis automatico).

Style Part

Muestra la asignacion de parte del canal seleccionado dentro de una seccion.

Zone Setting

Divide el area y establece la operacion para los canales anteriores (partes de
estilo asignadas a canales) dentro de un registro de seccién.

Lo Zone

Split

Determina dénde separar Lo Zone y Main Zone.
Introduzca el valor de nota mas grave (-, 1 a 127) de la Main Zone.
Si el valor es “-; se desactivaran los ajustes de la Lo Zone.

Style Playing
Parameter

Muestra el Style Playing Parameter para Lo Zone (no se permite el ajuste
automatico ni la edicién).

Convert to Style

Determina las reglas de conversién de nota para la Lo Zone al convertir a un

Parameter estilo.
Hay cuatro opciones: Root only, Active for Main, Semi-active Bass, y -.
HiKey Determina el valor estandar (0 a 11: C a B) para cambiar si se sube/baja el tono
(High Key) durante la reproduccioén de estilos para la Lo Zone.
Cuando se especifica una nota superior a este valor como nota fundamental del
acorde durante la reproduccion, la transposicion sera hacia abajo.
LoLim Determina el valor minimo de transposicion (0 a 127) durante la reproduccién de
(Low Limit) estilos para la Lo Zone.
Si el resultado del célculo de transposicién se convierte en un numero inferior a
este valor durante la reproduccién, se realizaran acciones como el plegado de
octavas o la detencion del sonido de acuerdo con el Style Playing Parameter.
HiLim Determina el valor maximo de transposicion (0 a 127) durante la reproduccion
(High Limit) de estilos para Lo Zone.

Si el resultado del calculo de transposicion se convierte en un nimero superior a
este valor durante la reproduccion, se realizaran acciones como el plegado de
octavas o la detencién del sonido de acuerdo con el Style Playing Parameter.
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Nombre del elemento Descripcion
Zone Setting Main Zone Style Playing Determina el Style Playing Parameter para Main Zone.
Parameter
Convert to Style Determina las reglas de conversion de nota para Main Zone al convertir a un
Parameter estilo.
HiKey Determina el valor estandar (0 a 11: C a B) para cambiar si se sube/baja el tono
(High Key) durante la reproduccion de estilos para la Main Zone.

Cuando se especifica una nota superior a este valor como nota fundamental del
acorde durante la reproduccion, la transposicién sera hacia abajo.

LoLim Determina el valor minimo de transposicién (0 a 127) durante la reproduccién de
(Low Limit) estilos para Main Zone.

Si el resultado del célculo de transposicidn se convierte en un numero inferior a
este valor durante la reproduccién, se realizaran acciones como el plegado de
octavas o la detencion del sonido de acuerdo con el Style Playing Parameter.

HiLim Determina el valor maximo de transposicion (0 a 127) durante la reproduccion
(High Limit) de Estilos para Main Zone.

Si el resultado del célculo de transposicion se convierte en un nimero superior a
este valor durante la reproduccion, se realizaran acciones como el plegado de
octavas o la detencion del sonido de acuerdo con el Style Playing Parameter.

Hi Zone Mega Voice Determina si se realiza el procesamiento MegaVoice en las notas de Hi Zone
(C6 o superior).

Si esta marcada, las notas por encima de C6 o superiores no se convertiran y
seguiran reproduciéndose correctamente al utilizar MegaVoice.
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B Acerca de Style Playing Parameters

Son reglas de conversion de nota que permiten que cada parte de una seccidn corresponda a una especificacion de acorde
durante la reproduccién de un estilo.
La eleccion de ajustes predefinidos que se ajusten a las caracteristicas de cada parte garantizara la calidad y precision de su

interpretacion.

Nombre del ajuste
predefinido

Descripcion

Bass

Para la parte de graves de la seccion Main/Fill.

Bass (Intro)

Para la parte de graves de la seccion Intro/Ending.

Chord

Para una parte que consiste principalmente en acordes de varias notas de la seccién Main/Fill.

Phrase chordal

Para una parte que consiste principalmente en acordes dispersos de una sola nota (arpegios, etc.) de la
secciéon Main/Fill.

Phrase melodic

Para una parte que consiste principalmente en frases melddicas de una sola nota de la seccién Main/Fill.

Para una parte que utiliza una voz de guitarra y consiste principalmente en acordes de varias notas (golpes

Guitar Stroke de acorde, etc.) de la seccién Main/Fill.
. . Para una parte que utiliza una voz de guitarra y esta formada principalmente por acordes dispersos de una
Guitar Arpeggio . - .
sola nota (arpegios, etc.) de la secciéon Main/Fill.
Chromatic Para una parte que consta principalmente de frases de escala cromatica de la seccién Main/Fill.

Maj-min (Intro)

Para una parte que no sea graves y Phri-2, de la seccién Intro/Ending.

Drum with cymbal

Para una parte que utiliza un conjunto de bateria con platos Crash.

Drum no cymbal

Para una parte que utiliza un conjunto de bateria sin platos Crash.

SFX

Para una parte que utiliza el kit SFX.

Sin asignacion (si no hay asignacion de parte).

NOTA

Las partes ajustadas a Bass (Intro) o Maj-min (Intro) estan fuertemente influenciadas por la clave de la seccion de esa parte.

B Acerca de Convert to Style Parameters

Estas son las reglas para convertir notas en canales a notas en partes de estilo.

Nombre del ajuste

predefinido R T
no change Las notas no se modificaran.
Root only Sélo se reproduce la nota fundamental del acorde.
Root & 5th Sélo se reproduciran la nota fundamental del acorde y la 5.2 perfecta.

Semi-active Bass

Se reproducira la interpretacion original con algunas posibles limitaciones. La estabilidad
general y la idoneidad para especificar acordes durante la reproduccion de Estilos
pueden ser inferiores a “Root Only”

Stable for Main

La reproduccién estable de acordes de varias notas es posible para acordes
especificados durante la reproduccion de estilos.
Sin embargo, es posible que la interpretacion original no se reproduzca con exactitud.

Active for Main

Si los resultados del andlisis de acordes durante el andlisis son adecuados, la
interpretacion original se reproducira con precision. Si hay errores en los resultados del
analisis de acordes, el estilo convertido puede ser musicalmente inapropiado.

Guitar Stroke

Ajustes exclusivos de “Guitar Stroke”

Guitar Arpeggio

Ajustes exclusivos de “Guitar Arpeggio”
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B Restricciones en las opciones de Convert to Style Parameter

Apéndice

Las opciones de Convert to Style Parameter cambian en funcion de los ajustes de Style Playing Parameter, como se muestra en

la tabla siguiente.

Style Playing Parameter

Bass

Bass
(Intro)

Chord

Phrase
chordal

Phrase
melodic

Guitar
Stroke

Guitar
Arpeggio

Chromatic,

Maj-min (Intro),
Drums with cymbals,
Drums without
cymbals, SFX

Convert to Style
Parameter

no change

O

Root only

Root & 5th

Semi-active
Bass

Stable for Main

Active for Main

Active root
only

Active root &
5th

Guitar Stroke

Guitar
Arpeggio
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Resolucion de problemas

Si la aplicacion no funciona normalmente, realice las siguientes comprobaciones para determinar si el problema se puede
corregir con los procedimientos sugeridos.

Problemas

Causas posibles

Soluciones

Los archivos no se pueden guardar
(transferir) al instrumento aunque la
aplicacion esté conectada a él.

No hay instrumentos configurados para
ninguno o ambos MIDI Input/Output Device.

Asegurese de que el instrumento conectado
esta correctamente configurado como MIDI
Input/Output Device en Ajustes.

No se pueden especificar acordes desde el
instrumento durante la vista previa de estilo
aunque la aplicacion esté conectada al
instrumento.

El [ACMP] del lado del instrumento esta
activado. Cuando [ACMP] esta activado, la
informacién de acordes sélo se envia al
instrumento y no al ordenador.

Apague el [ACMP] del instrumento.

La pantalla de la aplicacién se oscurece.

La ventana se maximiza. Si se utiliza la
aplicacion con la ventana maximizada, la
visualizacién de otras ventanas puede verse
distorsionada debido al procesamiento del
sistema operativo.

¢ Pulse la tecla [ESC] para cancelar la
maximizacion de la ventana.

» Utilice la aplicacion sin maximizar la
ventana.
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